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1.0 INTRODUCTION 

1.1 Overview 

This document serves as a user’s guide for the CritView code, version 1.05.  It supersedes the 
previous revision (Rev. 1), which was applicable to version 1.04 of CritView.  This release of 
CritView also includes version 1.09 of the database, which replaces version 1.08.   

The CritView code is used as an electronic equivalent of a nuclear criticality handbook (e.g., 
ARH-600).  This code takes an electronic data library and allows the user to plot data as needed.  
This approach has two distinct advantages over a paper handbook.  First, the database can be 
easily expanded to include additional data sources (e.g., other handbooks, configurations, or 
modeling techniques).  Secondly, the code provides flexibility by allowing the user to easily 
change the units and parameters of the plots.      

CritView provides the ability to quickly and easily change the axis parameters and units of the 
plot.  For example, a plot showing the relationship between critical sphere radius and 
concentration can be converted to show the relationship between critical mass and concentration.  
Similarly, if the plot shows concentration in units of g/cc (for example) it can be changed to g/L.  
Other major functionality includes the ability to compare curves, to list out the curve data in 
tabular form, and to export the plot to a graphics file for use in a document.   

The CritView code is intended to support evaluating the behavior of various fissile 
configurations (e.g., minimum critical mass, minimum critical diameter, etc.).  The data included 
in the associated database (like the data in ARH-600 itself) is typically a best estimate of critical 
(i.e., keff = 1.0) and does not include accommodation for uncertainty or bias.  As such it can be 
somewhat non-conservative and should not be considered as providing subcritical limits.  The 
code is primarily intended as a scoping tool for estimating minimum critical configurations, and 
for determining potential areas of interest in a criticality safety parametric study.  It is not 
intended to supplant analysis of specific configurations.  In general, it is recommended that the 
code not be used to directly set limits or controls for criticality safety. 

CritView was originally developed at Hanford under charter from the DOE NCSP for use by the 
nuclear criticality safety community.  It is distributed through the NCSP’s web site 
(ncsp.llnl.gov).  At the time of this document, the code is being maintained by SRNS under 
contract to the NCSP. 

At the time of this document, the current version of CritView is 1.05, and the associated database 
is version 1.09.  The database is encapsulated in two files: CritViewDB.ar and CritViewDB.txt.  
The “ar” file is a binary version of the database and is the recommended file for normal use (it is 
loaded by default if present).  The “txt” file is an ascii text version and can be used to recreate 
the binary file (which is done automatically if the binary file is not present).  The current version 
of CritView should not be used with older versions of the database file.  Similarly, the current 
database should not be used with older versions of the code.  Later versions of the database, 
if/when released, may be used with this version of CritView unless the release document 
associated with the new database file indicates otherwise.  Additional details pertaining to the 
database file can be found in Appendix C and Appendix D.   
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Use of the CritView code is supported by the NCSP CritView code custodian, as indicated on the 
NCSP web site (http://ncsp.llnl.gov/analytical-methods/critview).  For any questions or issues 
associated with the use of the code, including bug reports, the user should contact the code 
custodian.   

1.2 Changes with this Revision 

Revision 1.05 of CritView represents a substantial rewrite of the underlying code to improve 
efficiency and simplify future work.  Most of the changes, however, are largely transparent to the 
user.  The major changes to the functionality are:  

The addition of all LA-10860 curves to the database. 

The addition of SCALE6.1 curves to the database. 

Improvements to the database filtering process to allow curves with non-standard parameters to 
be selected.  This facilitates the use of LA-10860 data. 

Addition of several new parameters to the filtering capability 

Refinements to the isotopic content filtering capability 

Improvements to the labeling consistency in the database file 

Minor bug fixes and improvements to aesthetics. 

This revision of the code also introduces a new version the database, which includes some 
significant changes.  The database is discussed further in Appendix C. 

2.0 SYSTEM REQUIREMENTS 

This version of CritView is intended for installation on a desktop PC running a Microsoft 
Windows operating system (Windows 10 or newer).  At least 16 MB of free disk space are 
required. 

Any additional requirements for use of this code are identified on the NCSP web page. 

There are no specific training requirements for use of this code; however, a working knowledge 
of Microsoft Windows and some familiarity with criticality safety handbooks (e.g., ARH-600 
and LA-10860) is recommended. 

3.0 INSTALLATION 

This software is a “console”-type application and does not require a formal installation (i.e., no 
changes are made to the Windows registry).  Installation consists of copying the executable file 
and the database files to an appropriate folder on the computer where it will be used.  The 
executable file is named CritView_v###.exe where the “###” is the code version number (e.g., 
CritView_v105.exe).  There are two database files that will normally be present (although the 
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code can be used with just one).  The first is the text version of the database and is named 
CritViewDB.txt.  The contents of this file are in text format and begin with comment lines 
identifying the version number.  The second file is the binary formatted version of the database.  
It is named “CritViewDB.ar”.  Note that the binary file can be recreated from the text file but 
that the text file cannot be regenerated from the binary file. 

When first using the software on a given computer, the user should run the example case given in 
Appendix A and confirm the results are correct.  This practice serves as installation testing for 
the code. 

4.0 CODE USE 

This section describes some of the basic functions that the user is likely to need.  Additional, 
more detailed, descriptions are provided in Section 5.  

4.1 USER INTERFACE 

The CritView code is a Windows-based software package that uses menus and on-screen 
selections as its user interface. 

Most code actions are initiated by selecting a menu option.  The menu is available through a 
menu bar across the top of the window (just above the plot).  This bar provides the basic menu 
options, each of which will bring up a small sub-menu window that provides access to various 
operations.  A detailed description of the various menu options available is provided in 
Section 5. 

Additional user options are available by left clicking elements of the plot.  Most elements of the 
plots are clickable (e.g., the curves, individual data points, axis numbers, labels, etc.).  Left 
clicking on an element once will (typically) highlight it and double clicking will bring up a 
format window for that element.   

A curve can be selected either by left clicking on it directly or by left clicking on its 
representation in the legend box. Selecting a curve  will cause the individual data points in that 
curve to be selected (i.e., highlighted).  Left clicking anywhere on a selected curve will cause the 
X and Y values of the nearest point to be displayed on the screen.   

4.2 GETTING STARTED 

The code is normally started by double clicking the CritView icon from Windows Explorer.  The 
code will first check for the presence of the default binary database file (CritViewDB.ar). If it is 
found, it will read the file and proceed.  If the binary file is not found, it will attempt to read the 
default text database file (CritViewDB.txt).  If the text version is found, it will be read and a 
corresponding binary file will be created.  Note that reading the text file can take a significant 
amount of time – up to several minutes – depending on the size of the file and the speed of the 
computer.  If neither the binary file nor the text file is found, the code will bring up a pop-up that 
allows the user to select a database file for processing.   
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After the code has read in the database file it will select available curves from the database, 
based on the default filter values (e.g., 239Pu, sphere).  These selected curves will then be plotted 
onto the screen.  It will then display an ‘About CritView’ box that identifies the code and 
database versions and requires the user to click on “ok” before proceeding.  After the user clicks 
“ok”, the welcome box will close and the user may begin using the code to select new curves or 
to alter the display of the default curves. 

4.3 SELECTING CURVES 

The database files may contain data for hundreds or thousands of curves.  Typically, it is not 
desirable to plot them all at once.  CritView provides tools for filtering the data so that only the 
curves the user actually wants to see are displayed.  There are two tools available: “Quick 
Select” and “Advanced Select”.  The advanced select tool allows the user to specify any 
combination of parameter values that are available in the database.  The quick select tool limits 
the choices to a subset that includes the most common parameter combinations.  This reduces the 
options available but is easier to use and more intuitive for some people.  Additional details of 
these two tools are discussed in Section 5.   

The user can activate the quick select tool by pressing the ctrl-Q keys.  Alternately, either tool 
can be activated by clicking on the Select Data menu option, followed by clicking on either 
“Quick Select” or “Advanced Select”.  Either option will bring up a Windows dialog box 
(specific to the selected tool) from which the user can select any of several different available 
parameter values of interest (these selections are referred to as “filters”).  A typical filter 
selection would be: 

• Geometry: sphere;  

• Critical material: Pu;  

• Moderator material: H20;  

• Nuclide: Pu240 = 0.0 wt%;  

• Reflector thickness: = 0.0 cm;  

• Data source: ARH600 primary   

If this still produces too many curves, additional filters can be applied, or the Hide Curve option 
(see below) could be used to eliminate unwanted curves from the plot.   

The actual filters (and filter values) available are dependent on the curves included in the 
database.  Appendix B provides a description of the filters available with the current version of 
the database. 

4.4 HIDING CURVES 

Specific curves can be removed from the plot (without the use of filters) by selecting the 
Hide/Show Curves option under the Format menu.  This will bring up a Windows dialog that 
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will list all the curves currently on the plot.  Clicking any of the curve titles will move it from the 
Show list to the Hide list (clicking it again will move it back to the Show list).  When the dialog 
is closed the plot will be redrawn with only those curves in the Show list. 

4.5 CHANGING THE PLOT AXES 

The parameters associated with the plot axes (e.g., mass, radius, concentration), as well as the 
corresponding units (e.g., grams, kg, pounds) can be changed using the Select Axis Parameter 
menu option.  Note that not all curves can have the parameter changed.  Some changes are illegal 
(e.g., changing from critical radius to critical volume is not allowed for an infinite cylinder) and 
some changes are possible only if all necessary data is included in the database.  For example, a 
plot showing mass vs. concentration  of a sphere can be converted to a volume vs. concentration 
plot but only if the database includes the volume data for that curve (or other data, such as radius, 
that allows the volume to be calculated).   

There is also a Swap Axes option that will swap the X axis parameter with the Y axis parameter 
(e.g., a mass vs. diameter plot becomes a diameter vs. mass plot). 

4.6 CHANGING THE PLOT APPEARANCE 

Most aspects of the plot appearance can be changed as desired.  The plot title and the axes titles 
can be changed by double clicking on them.  The axes labels can be changed (as well as the 
scale, log vs. normal, and other plot settings) by double clicking on the desired axis or by using 
the “Format” menu option.  The appearance of the individual curves can be changed by double 
clicking on them (or on the matching line in the legend box).  This allows the user to change the 
line style and color, and to specify the curve title to be used in the legend.  The general 
appearance of the legend box can be changed by double clicking on it (or using the “Format” 
menu option).  All options can be restored to their original values by selecting the Reset Plot 
option under the Tools menu. 

The legend box can also be moved or resized using the standard windows move and resize 
cursors. 

4.7 VIEWING NUMERICAL DATA 

The numerical values of the underlying data points plotted on the screen can be viewed in two 
different ways.   

The first option is to use the “View” tab (see Section 5.2).  Typically, the user would select a 
curve of interest by clicking on it (it will highlight) then selecting the “View” tab followed by the 
“View Data from Selected Curve” option.  This will bring up a menu, which will provide several 
ways to select the specific curve you want to look at.  Once a curve is selected, the code will 
bring up a dialog box showing the key curve parameters and a point-by-point listing of the 
plotted data.  Note that this is the raw data in the database, not necessarily the parameters or units 
selected for plotting. 

The second method is through querying the plot directly.  Clicking on a point on a curve will 
result in the X and Y values for that point being displayed on the screen.  Note that this is the 
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plotted data, not the raw data.  The raw data may have been converted to conform to the selected 
axes parameters and units to generate the plots. 

 

4.8 EXPORTING A PLOT TO A FILE 

A plot may be saved as a standard graphics file by selecting the “Export Plot to File” option 
under the “File” menu option.  This will bring up a standard “Save File” dialog with the default 
file type set as JPEG.  Other file types can be selected as discussed in Section 5.1.  Note that it is 
important to use the correct suffix in the file name or else leave it blank; if the file named entered 
does not include a suffix, then the code will add the appropriate suffix.   

4.9 PRINTING THE PLOT 

The CritView code includes a print feature that may be utilized by selecting the File menu option 
followed by the Print option.   

4.10 COMPARING CURVES 

The difference between any two curves on the plot may be examined by selecting the Compare 
Curves option under the Tools menu.  This will bring up a Windows dialog box that lists all the 
curves on the plot.  From here, the user may select two of these curves for comparison.  CritView 
then creates a new curve by subtracting (on a pointwise basis) the second curve from the first.  
This function is described further in Section 5.6.  

5.0 CODE OPTIONS 

This section provides a detailed description of all the available CritView menu options.  The 
CritView commands are available through a menu system located on the menu bar at the top of 
the code window.  This section is broken down into subsections for each option on the menu bar, 
and then further broken down to describe submenus and options underneath each top-level 
option. 

5.1 FILE 

Selecting the “File” tab brings up a menu that offers the following commands: 

• Print Preview Displays the plot on the screen as it would appear printed. 

• Print Setup Selects a printer and printer connection. 

• Print Prints the current plot. 

• Export Plot to File Creates a graphics file containing the current screen image. 

• Exit  Exits CritView. 
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Most of these are self-explanatory, but the “Export Plot to File” option deserves some additional 
discussion.  Selecting this option will bring up a dialog that allows the current plot to be saved to 
a standard graphics file.  This dialog allows the user to specify a directory, a file name, and a 
type.  The type indicates the type of graphics compression that will be used in saving the file.  
Note that each type has an implied suffix for the name.  If the user does not specify a suffix when 
specifying the file name, the code will automatically add the suffix associated with the selected 
type.   

The supported file types and suffixes are shown below.  The quality of the resulting image and 
the size of the file will vary with the file type selected.  Note: the resulting plot file will have the 
same resolution and aspect ratio as the plot displayed on screen. 

Available file types and suffixes:  

JPEG .jpg Highly compatible but not lossless; smallest sized file.  Recommended.  

Bitmap .bmp Highly compatible and accurate (lossless) but produces the largest file.  

PNG .png Less compatible, but smallest file for lossless method. 

TIFF .tif Reasonably compatible and lossless; intermediate file size.   

5.2 VIEW 

The “View” tab brings up a menu that offers the following commands: 

• Status Bar  Shows or hides the status bar. 

• View Data from Selected Curve  Lists parameter values and data points for currently 
selected curve. 

• List Curves Selected by Filter  Provides a means to list curve(s) currently selected by 
the filter. 

• List of All Curves in Database Provides a means to list any curve in the database.  

The last three options warrant some additional discussion.   

The “View Data from Selected Curve” option will produce a dialog window with a listing of the 
pertinent details from the currently selected curve.  The listing provides the curve title and other 
parameters specified in the database, and the raw curve data (not necessarily the data in the plot).   

The “List Curves Selected by Filter” option will produce a dialog window with a listing of all the 
curves (by title) that are currently selected by the filter.  One or more of these curves may be 
selected (use the ctrl-click to select multiple curves), then viewed by clicking on the “View 
Curve” button.  This will list the data for each of the selected curves just as if they had been 
highlighted and the “View Data from Selected Curve” option had been used. 
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The “List of All Curves in Database” option will produce a dialog window with a listing of all 
the curves (by title) in the database.  Note that there are typically thousands of curves in the 
database.  One or more of these curves may be selected, then viewed by clicking on the “View 
Curve” button.    This option will also list the data for each of the selected curves just with the 
above options. 

5.3 SELECT DATA 

The “Select Data” tab brings up a menu that offers the following commands: 

• Quick Select 

• Advanced Select 

These two options each bring up a different data selection dialog.  These dialogs allow the user 
to filter the database so only the curves of interest are plotted.  If no filters are specified all 
curves in the database will be plotted.  This could be many thousands of curves, which would be 
time consuming to plot and not very useful; therefore, the user should take care to select 
appropriate filters.   

The “Quick Select” dialog includes an assortment of the most common parameters (e.g., 
geometry, fissile element, reflector thickness), each of which is presented on a separate tab. 
When a specific tab is selected then a dialog is brought up for that parameter and certain default 
settings are activated.  Once this dialog is activated, a corresponding filter is implemented.  The 
user can change the settings (by clicking the various boxes or buttons) but cannot leave all the 
settings blank.  If the user attempts to uncheck all of the boxes, the code will automatically check 
the predefined default box.  It is not possible (using the Quick Select tool) to eliminate the filter 
once it is created in this manner.  This tool provides a quick and reasonably intuitive manner of 
selecting the parameters of interest, resulting in a set of curves to be plotted.  The tool is limited, 
however, to specific predefined options.  It may not be useful if the user desires to look at some 
of the more esoteric data, or if the user has added their own data to the database. 

The “Advanced Select” dialog allows the user to specify filters based on all the various 
parameters and parameter values that exist in the current database.  This is a very flexible tool 
but is less intuitive to use.  It is recommended only for advanced/experienced users or 
non-standard data. 

The filters available in the advanced tool depend on the curves present in the database; any 
parameter specified in the database will show up as a potential filter.  For example, if any curve 
in the database specifies a value for “Volume,” uses volume as a variable, or provides sufficient 
information to calculate the volume, then “Volume” will appear in the list of potential filters.  If 
the volume is not available for any of the curves in the database, it will not appear as a potential 
filter.   

In the advanced tool, a filter is selected by clicking on its name under the available filter list and 
then clicking the “Add” button, or by just double clicking on its name.  This will bring up a 
dialog box specific to the filter type.  In the filter dialog the user will be able to specify a valid 
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value or range of values for the parameter.  Once this filter has been added, only curves having 
one of the selected values (or falling within the specified range) will be plotted.  After clicking 
the OK button, the filter dialog will close, and the filter selection dialog will reappear (with the 
new filter in the “Current Filters” list).  A filter may be modified or deleted by selecting it from 
the list of current filters and clicking on the appropriate button.  The “Delete All” button will 
delete all current filters without the need to first select them. 

5.4 SELECT AXIS PARAMETER 

This option brings up a menu that provides three options:  

• X axis  

• Y axis  

• Swap Axes 

If either of the first two options is selected, it will produce a dialog box providing a list of 
possible parameters for the axis, along with a list of valid units for the selected parameter.  
Initially the current parameter and units are selected.  If a new parameter is selected, the units 
will default to the first one in the list.  If a new parameter and/or new units are selected, the plot 
will be regenerated with the new axis parameter and/or units.  Note that, in some cases, it is 
possible to select parameters that are not valid for all the curves in the plot.  In this case the 
affected curves will not be plotted.   

If the “Swap Axes” option is selected, then the current parameter and units on the X axis will be 
applied to the Y axis and vice versa. 

5.5 FORMAT 

The Format option brings up a menu that provides the following options: 

• X axis  

• Y axis 

• Legend Box 

• Hide/Show Curves 

Each of these options are described further in the following subsections. 

5.5.1 Format Axis (X or Y) 

This option will produce a dialog box allowing the user to set various scale and style options for 
the axis as described below.  Note that this dialog can also be activated by double clicking on the 
given axis of the plot.  [The values in this dialog may be entered as decimal numbers (0.01, 10) 
or may be entered using scientific notation (1e-2, 1e1), etc.] 
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Log Scale 

Checking this box will result in the axis being plotted as a log scale rather than a linear scale.  
This will affect many of the other options below.  Note that a log scale may not ever cross the 
zero point on the axis.  Only positive ranges are allowed for log scale plots in CritView. 

Minimum Axis Value 

This is the minimum point on the resulting axis.  For a log scale axis, it is typically a power of 10 
(e.g., .001, 1.0, 1000.0, etc.). 

Maximum Axis Value 

This is the maximum point on the resulting axis.  It must be greater than the Minimum Axis 
Value.  For a log scale axis, it is typically a power of 10 (e.g., .001, 1.0, 1000.0, etc.). 

Major Tic Delta 

For a linear scale axis this is the increment between primary tic marks on the resulting axis.  This 
can be any number greater than 0 but typically will not be less than about 5% of the difference 
between the maximum and minimum axis values.  If this value is too small the plot will likely be 
unreadable due to the large number of tic marks and corresponding grid lines. 

For a log scale axis, this value is not used.  

Minor Tic Delta 

For a linear scale axis this is the increment between secondary tic marks on the resulting axis.  
This can be any number greater than 0, but typically it would be a value that divides evenly into 
the major tic delta value.  It would typically not be less than 5% of the major tic delta value.  If 
this value is equal to, or greater than, the major tic delta value then no secondary tic marks will 
be placed on the axis.   

For a log scale axis, this value is not used.   

1st Major Tic > Min Axis Value 

Checking this box, for a linear scale axis, will result in the minimum point on the axis not 
defaulting to the first primary tic mark.  If this box is checked then a value must be specified for 
the First Major Tic Mark.   

This option has no effect on a log scale axis. 

First Major Tic Mark 

This value should only be entered if the “First Major Tic Not Min Axis Value” box is checked.  
This value specifies where on the axis the first primary tic mark will occur.  Subsequent primary 
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tic marks will be offset by a multiple of the “Major Tic Delta” value set above.  This value must 
be in the range of Minimum Axis Value <= x <= Maximum Axis Value. 

This value has no effect on a log scale axis. 

Show Major Gridlines 

If this box is checked gridlines corresponding to the primary tic marks will be drawn on the plot. 

Show Major and Minor Gridlines 

If this box is checked gridlines corresponding to both primary and secondary tic marks will be 
drawn on the plot.  If this box is checked the Show Major Gridlines box has no effect. 

Show Minor Tic Labels 

If this box is checked the values will be printed for the secondary tic marks (in addition to the 
labels for the major tic marks). 

Exponential Labels 

If this box is checked then axis labels will be printed in exponential format (e.g., 1.0E+1), 
otherwise they will be printed in standard format (e.g., 10.0). 

Decimal Places 

This value assigns the number of digits after the decimal point that will be printed in the tic mark 
labels.  This must be a non-negative integer.  If zero is entered, then no decimal point will be 
printed. 

Font 

Clicking this button will bring up the font selection dialog and allow typical font parameters 
(style, size, color, etc.) to be applied to the tic mark labels. 

Default 

Clicking this button will reset all values on this dialog to the default values (which, in some 
cases, are calculated based on the curves in the plot).   

5.5.2 Legend Box 

This option will produce a dialog allowing the user to set various style options for the legend box 
as described below.  Note that this dialog can also be activated by double clicking on the legend 
box. 
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Background Color 

Clicking this button will activate the color selection dialog box, which will allow the user to set 
the background color for the legend box.  The default color is white. 

Font 

Clicking this button will activate the font selection dialog and allow typical font parameters 
(style, size, color, etc.) to be applied to the text in the legend box. 

Change Curve Order 

Clicking this button will activate the curve order dialog, which allows the user to specify the 
ordering of the curves in the legend box. 

Background Transparent 

Checking this box results in a transparent legend box background; the text will be visible but 
underlying plots and gridlines will show through.  Note that this option overrides any 
background color that may be selected. 

Hide Legend 

Checking this box results in the legend box not appearing on the plot.  If this option is selected 
then the legend box may only be restored by activating this dialog through the Format – Legend 
Box menu option (i.e., you can no longer double click on the legend box to bring up the dialog). 

5.5.3 Hide/Show Curves 

This option activates the Hide/Show curve dialog.  This dialog provides a list of visible curves 
and a list of hidden curves (initially all curves on the plot are visible).  Clicking on a curve in one 
list will switch it to the other.  Any or all the curves in the plot may be hidden in this manner.  
This provides an alternate method for limiting the curves in the plot (as opposed to setting 
additional filters).  Once curves are hidden they can only be restored by using the Hide/Show 
curve dialog.   

Modifying the data filters (using either the quick select or advanced select tool) cancels the 
“hidden” property even if the same curves are selected. 

5.6 TOOLS 

The Tools option brings up a menu that offers the following options: 

• Compare Curves 

• Reset 

• Load New Database File  
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Compare Curves 

This option provides a means for comparing two curves.  It brings up a dialog that lists all the 
curves in the current plot.  Any two of these may be selected for comparison.  The second curve 
selected will be subtracted from the first on a point-by-point basis.  The resulting curve will be 
added to the plot.  This new curve has the same units as the originals but may have a radically 
different magnitude, so the range of the Y axis may need to be adjusted before this curve is 
visible.  The order of selecting the two curves will determine whether the resulting curve is 
positive or negative, so the larger curve is typically selected first.  Note that the Y axis extents 
may need to be changed to show the resulting curve, and negative value curves won’t show up at 
all on a log plot.  If the data filters, or axis parameters, are changed then any new curves created 
through this tool will be deleted.  Note that the two curves selected as a basis for the new curve 
must both be monotonic with respect to the X axis. 

Reset Plot 

This option resets all plot parameters and options to initial conditions.  This includes fonts, axis 
parameters and ranges, hidden curves, and filters. 

Load New Database File 

This option allows users to load (or re-load) an existing CritView database file.  Selecting this 
option brings up a Windows file selection window from which the user can select a new database 
file.  The selected file can be either a standard ascii file (typically with a “.txt” suffix) or a binary 
database file (typically with a “.ar” suffix).  The selected file must have a format compatible with 
the CritView code version.   

Loading a new database will replace any existing filters (or plot settings) with the default values.  
It may be necessary to modify the default filters and settings to be consistent with the new 
database file.  

Note that loading a new ascii database file will result in the code overwriting any existing binary 
database file.  Users are advised to maintain a backup copy of any needed database files. 

 

5.7 HELP 

The Help option brings up a menu with the following option: 

About CritView 

Selecting this option will bring up a window that displays the version number of the code and of 
the currently loaded database file. 
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6.0 CODE WARNINGS AND ERROR MESSAGES 

This section describes some warning messages that may be encountered by CritView users.  
These warnings show up in a Windows pop-up text box when certain conditions occur.  The 
situations where they are typically encountered, and the appropriate user actions in response, are 
described below. 

•  “No Curves Selected! – Current filter settings exclude all curves!” 

This message appears when the user selects filters that are contradictory or otherwise 
exclude all the curves in the database.  If the indicated filter is applied then the CritView 
plot (i.e., the axes) will be displayed but there will be no curves on the plot.  When this 
warning is encountered the user should modify the selected filters.  The current version of 
CritView prevents most such filter contradictions but it can still occur if inappropriate 
ranges are selected for one of the real valued parameters (e.g., reflector thickness).  

• “Curves not monotonically changing in x direction - cannot calculate difference” 

This warning can occur when the user activates the “Compare Curves” function (under 
the “Tools” menu option).  If either of the curves selected for comparison is not 
monotonically changing in the X direction, the comparison cannot be performed.  This 
pop-up message will occur and, after clicking “ok,” the user will be returned to the same 
plot as was shown before the comparison was attempted.  Note that “monotonically 
changing in the X direction” means that curve increases or decreases over the entire 
curve.  For example, monotonically increasing means that every data point in the curve 
(from first to last) must have an X value greater than the X value of the preceding data 
point. 

• Various “aborting” error messages 

The CritView code has additional built in error messages indicating that an error has 
occurred, and the program will shut down.  These errors typically indicate a problem with 
the database file but could represent an actual bug in the code.  None of these should be 
encountered during normal use of the code.  If such an error does occur, the user should 
note the filter options and axis parameters in use at the time the error occurred.  The user 
should report the error to the code custodian as indicated on the NCSP web page. 

7.0 REFERENCES 

ARH-600, 1968, Criticality Handbook, R.D. Carter, G.R. Kiel, and K.R. Ridgeway, 1980 
Revision, Atlantic Richfield Hanford Company, Richland, Washington. 
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Appendix A Example Problem 

This appendix presents a sample exercise with the CritView code.  This serves as both a simple 
case to acquaint the user with the code and as an installation test case to confirm the code is 
working properly on a given computer. 

For this example, the user will plot curves representing critical mass vs. concentration for 
plutonium spheres reflected by water.  A series of manipulations will then be performed on these 
curves to test the functionality of the code. 

The first step in the test is to start up the code.  The test should always be performed with a fresh 
instance of CritView; this simplifies the setup required for the test. 

After starting the code, click “ok” on the welcome window  to close this window (and accept the 
default filters). 

The resulting screen should look like the plot shown in Figure 1.  

Figure 1 
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This is the default CritView plot.  It shows three curves based on a pure 239Pu sphere: an 
unreflected sphere; a sphere with 1″ of water reflection; and a sphere with full (10″) water 
reflection, all taken from the MCNP data set in the database file. 

Next, to the user should look at the corresponding curves with 5% 240Pu.  To accomplish this, it 
is necessary to modify the default filters.  The filters can be modified using the “Quick Select” 
tool.  Open the Quick Select tool by clicking on the “Select Data” tab and then clicking on 
“Quick Select”.  On the “Isotopics” tab of the Quick Select tool, click on the “Set Range” button 
for 240Pu.  This will bring up a dialog box that allows the user to set the desire value or range.  
First, click on the radio button labeled with the “=” symbol, then enter “95.0” in the box after the 
“=” sign and select “wt%” in the units box.  Next, click the “ok” button to close the isotopics 
dialog and again to close the quick select dialog. 

CritView should now show the plot seen in Figure 2. 

Figure 2 
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The next task is to change the look of plot.  The lines will be changed so that they are easier to 
distinguish should a black and white copy be made.  To do this, first double click on the top line, 
either on the plot or in the legend box.  This will bring up a “Line Style” format box.  Find the 
entry for “Line Style” and change it from solid to dash, also change the line width from “2” to 
“3”, then click ok.  Repeat this for the bottom curve, changing its style from solid to dot.  Next, 
we are going to change the scale of the plot.  First double click on the X axis; this will bring up 
an X axis settings box.  Change the maximum axis value from 100,000 to 20,000 and click ok.  
Next, repeat this process for the Y axis, changing the minimum axis value from 100 to 400, and 
the maximum axis value from 100,000 to 30,000.  Now the plot has zoomed in on the curves.  
Note, however, that the legend box now covers some of the data.  Click and drag on the legend 
box and move it to the upper left portion of the plot so it doesn’t cover any data.  The resulting 
plot should now look like Figure 3. 

Figure 3 
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The next step is to convert the plot from mass vs. concentration to volume vs. mass.  In addition, 
the mass axis will be changed from units of grams to units of kilograms.  Click on the “Select 
Axis Parameter” menu option and select “Y Axis.”  Change the parameter from mass to volume 
and the units to liters and click on the “ok” button.  Repeat this process for the X axis, changing 
the parameter from fissile concentration to fissile mass, and setting the units to kilograms.  The 
resulting plot should look like Figure 4. 

Figure 4 
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Next, remove the 1” reflection curve and just look at the unreflected and full reflected cases.  To 
accomplish this, click on the Format tab, followed by the Hide/Show Curves menu option.  Find 
the curve (corresponding to 1” reflection) in the left side box (visible curves) and click on it.  
The curve title should move from the left side box to the right side box (hidden curves), then 
click “ok”.  The resulting plot should look like Figure 5. 

Figure 5 
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Finally, we want to test the data to be sure that all these calculations have worked correctly.  
Click on the left most curve (i.e., the fully reflected case) to highlight it.  This will also highlight 
each of the individual points on that curve.  Next, click on the bottom most (lowest volume) 
point on this curve.  This will bring up the X and Y (i.e., mass and volume) values for that point.  
The result should look like Figure 6. 

Figure 6 

 

Confirm that the X and Y values are 5.90E+000 kg and 3.01E-001 L. 

Now to double check those numbers, click on the “View” menu option and select the “View 
Data from Selected Curve” option.  This will list pertinent details associated with the curve (e.g., 
the source and the reflector thickness).  It will also list all of the X and Y values for this curve 
(showing more significant digits than the method above).  The concentration (in g/cc) and the 
diameter (in inches) will be listed for each point.  The last point in the list will be for the lowest 
diameter, which will correspond to the smallest volume point on the plot.  This point should be 
concentration = 19.6 g/cc and diameter = 3.2737 inches.      Using basic geometry, show that 
these values correspond to the above stated mass and volume.   

 

A good follow-on exercise is to go back to the Select Data option and change the Data Source 
filter to include both the ARH600 and MCNP options.  This will result in both sets of data being 
plotted on the same graph.  Comparing the two sets of data one can see that they are in 
reasonably good agreement in most places, but there are some significant differences.  In 
particular, note that the minimum critical mass calculated by MCNP is (in many places) about 
5% lower than the corresponding ARH-600 value.  Bear in mind, also, that the MCNP data is not 
adjusted for bias or uncertainty; if these factors were accounted for then the MCNP values would 
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be lower still.  This demonstrates why the data in this code (and in ARH-600 in general) is not 
considered precise enough for setting critical limits. 
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Appendix B CritView Advanced Data Selection Filter Options 

The filters available in the advanced data selection dialog of CritView are derived from the 
database file loaded when the code is run.  Strictly speaking, these filters can be different for 
different versions of the database file but in practice there is generally little change.  This section 
describes the various filter options deriving from the current version of the database file. 

Each of the available filters, and their possible values, are described in the following subsections. 

Unless otherwise indicated, filters can be set to any number of the available options.  Units 
(when present) must be set to just one of the available options. 

B.1 Acid Density 

This filter allows the user to put restrictions on the acid density (e.g., g/L nitrate) of the critical 
material associated with the curves to be plotted.  This applies only to nitrate solution curves.  
There are very few curves in this version of the database that have this parameter as a constant; 
therefore, this filter is not normally used. 

B.2 Acid Molarity 

This filter allows the user to put restrictions on the molarity associated with the curves to be 
plotted.  Note that this parameter is only defined for acid solutions.  In the current version of the 
database, the only values available are 0, 3, and 6. 

B.3 Annulus Thickness 

This filter allows the user to put restrictions on the annulus thickness for curves that are based on 
annular geometries. 

B.4 Area 

This filter allows the user to put restrictions on the area of the fissile geometry.  This is most 
applicable to cylinders but can also be calculated for spheres. 

B.5 B/X 

This filter allows the user to put restrictions on the B/X ratio (i.e., the boron to fissile element 
ratio) in the fissile material.  Only a few curves in the current database include B/X information, 
and none have this parameter as a constant, therefore specifying this filter will have limited 
usefulness. 

B.6 Concentration 

This filter allows the user to put restrictions on the concentration of the critical material 
associated with the curves to be plotted.  There are very few curves in this version of the 
database that have this parameter as a constant (typically, it is a variable); therefore, this filter is 
not normally used. 
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B.7 Concentration - Areal  

This filter allows the user to put restrictions on the areal concentration of an infinite slab (plane) 
in the curves to be plotted.  There are no curves in this version of the database that have this 
parameter as a constant; therefore, specifying this filter will have limited usefulness.   

B.8 Concentration - Linear  

This filter allows the user to put restrictions on the linear concentration of the curves to be 
plotted.  Note that this parameter is only defined for cylinders (typically only for infinite 
cylinders).  There are no curves in this version of the database that this parameter as a constant; 
therefore, specifying this filter will have limited usefulness. 

B.9 Cross-Section Library 

This filter allows the user to put restrictions on the cross-section library used to model the 
various geometries (e.g., with MCNP or SCALE).  Currently there are only two cross-section 
libraries represented in the database: ENDF/B-VI.6 (MCNP), and ENDF/B-VII.1 (SCALE). 

B.10 Data Reference 

The Data Reference filter provides a means to select curves based on their reference (e.g., 
document and page number) rather than on their physical characteristics (e.g., diameter, 
concentration, etc.).  For example, if the (only) filter selected was “Data Reference” with a value 
of “ARH-600 III.A.3-1” then the resulting plot would show the curves from page III.A.3-1 of 
ARH-600.  Any additional filters set would restrict which of those curves were plotted. 

B.11 Data Set 

This filter allows the user to limit the curves plotted to those from specific data sets. Note that 
these are subsets of the Data Source option (see below).  

The data sets available in the current version of the database are: 

• ARH600 primary A subset of the ARH-600 curves that represent all relevant data 
(for keff = 1.0) contained in the database. 

• ARH600 secondary All ARH-600 curves not included in the primary set.  The data in 
these curves is generally duplicative of the data in “ARH600 
primary” but is taken from different figures in ARH-600. 

• ARH600 k=0.098 A subset of the ARH-600 curves that include only curves defined 
with a keff=0.098. 

• LA-10860 All curves in the database that derive from LA-10860. 
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• MCNP5 primary All curves generated with MCNP5; generally duplicates “ARH600 
primary” curves. 

• SCALE6.1 primary All curves generated with SCALE6.1; generally duplicates 
“ARH600 primary” curves. 

•  

B.12 Data Source 

This filter allows the user to limit the curves plotted to those from specific data sources.   

The data sources available in the current version of the database are: 

• ARH600 All included curves originating from the ARH-600 handbook.   

• LA-10860 All curves in the database that derive from LA-10860. 

• MCNP5 All curves in the database that derive from MCNP5. 

• SCALE6.1 All curves in the database that derive from SCALE6.1. 

B.13 Diameter 

This filter allows the user to put restrictions on the diameter (e.g., of a sphere or a cylinder) 
associated with the curves to be plotted.  There are no curves in this version of the database that 
have this parameter as a constant; therefore, specifying this filter will have limited usefulness.   

 

B.14 Fissile Element 

This filter allows the user to select which fissile elements will be included in the selected curves.  
The current version of the database includes the following three options: plutonium, uranium, 
and plutonium/uranium mix.  Note that selecting just plutonium (or just uranium) will exclude all 
the curves that contain a plutonium/uranium mixture. 

This filter, in conjunction with the fissile material form filter, accomplishes essentially the same 
function as the fissile material filter. 

B.15 Fissile Material 

This filter specifies the critical material (e.g., UO2, Pu) of the curves to be plotted.  There are 
many possible values for this filter in the database.  This filter accomplishes essentially the same 
function as specifying both the fissile element and fissile material form filters. 

Some of the more important fissile materials available in this version of the database are: 
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• Pu (elemental) Plutonium (typically in a metal-water mixture) 

• U (elemental) Uranium (typically in a metal-water mixture) 

• PuO2 Plutonium Oxide 

• UO2 Uranium Oxide 

• PuO2 + UO2 A mixture of plutonium oxide and uranium oxide.  Note that specifying 
a filter value of PuO2 and/or UO2 will exclude curves identified as 
PuO2 + UO2. 

In the case of solids (e.g., Pu or UO2) any given critical material applies to both pure materials 
and materials mixed with a moderator (if such are present in the database).  For example, 
specifying UO2 may produce curves that include pure UO2 and curves representing UO2 mixed 
with water.  Most often, the curves in the database represent a continuity of data ranging from 
unmoderated to highly over moderated. 

This filter accomplishes essentially the same function as the fissile material filter in conjunction 
with the fissile element filter. 

B.16 Fissile Material Form 

This filter specifies the critical material form associated with the curves to be plotted.  

In the current version of the database there are several fissile material forms available:  

• Compound (e.g., oxide),  

• Compound-water mixture, 

• Metal 

• Metal + solution 

• Metal-water mixture 

• Solution (e.g., nitrate),  

B.17 Geometry 

This filter specifies the geometry of the curves to be plotted. 

There are several geometries available in the current version of the database, including: 

• Annuli 

• Various arrays 
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• Cylinders (finite) 

• Infcyl (infinite cylinder) 

• Infplane (infinite plane or slab) 

• Lattice of rods (applies to only a single LA-10860 curve) 

• Slab in Cylinder 

• Sphere 

B.18 H/X 

This filter allows the user to put restrictions on the H/X ratio (i.e., the hydrogen to fissile element 
ratio) in the fissile material.  Only a few curves in the current database include H/X information.  
Currently the code does not provide a means to convert between H/X and concentration, 
therefore usefulness of this filter is somewhat limited. 

B.19 Height 

This filter allows the user to put restrictions on the height of an infinite plane in the curves to be 
plotted.  There are no curves in this version of the database that have this parameter as a 
constant; therefore, specifying this filter will have limited usefulness.   

B.20 Isotopic Composition 

This filter represents a family of filters that restrict the isotopic content of the various isotopes 
(e.g., pu239, u233).  CritView creates a filter for each nuclide present in the database.  These 
filters allow the user to put restrictions on the content of the specified nuclide.  For example, the 
240Pu content could be limited (by selecting pu240) to 5 wt%.   

B.21 Isotopic Mixtures 

This filter allows the user to select specific isotopic mixtures that are present in the database.  It 
accomplishes essentially the same function as the isomat filters but is more specific – rather than 
specifying ranges for each isotope the user just selects the specific isotopic compositions of 
interest.  For example, the plot could be limited to standard 5 wt% 240Pu curves by selecting the 
isotopic composition “Pu240 0.05 Pu239 0.95”.   

B.22 k-effective 

This filter allows the user to put restrictions on the keff associated with the curves to be plotted.  
There are only a few curves (currently, only some infinite plane cases) in this version of the 
database where the keff has a value other than 1.0; therefore, this filter has limited usefulness. 
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B.23 Length 

This filter allows the user to put restrictions on the length of certain geometries.  This is only 
applicable to finite cylinders and slabs. 

B.24 Mass 

This filter allows the user to put restrictions on the mass of fissile material in the curves to be 
plotted.  There are no curves in this version of the database that have this parameter as a 
constant; therefore, specifying this filter will have limited usefulness.  

B.25 Moderator Material 

This filter specifies the moderator material of the curves to be plotted.  The most commonly used 
value here is “H2O.”   

B.26 Radius 

This filter allows the user to put restrictions on the radius associated with the curves to be 
plotted.  There are no curves in this version of the database that have this parameter as a 
constant; therefore, specifying this filter will have limited usefulness.   

B.27 Reflector Material 

This filter specifies the reflector material of the curves to be plotted.  The most commonly used 
values here are “H2O” and “none.”  Some of the possible values include geometric aspects – 
such reflectors only apply to the corresponding geometries (e.g., “H2O 1 inch one side, full other 
side (slab geometry)” only applies to infinite planes).   

B.28 Reflector Thickness 

This filter allows the user to put restrictions on the reflector thickness associated with the curves 
to be plotted.  In the current version of the database, the most common values for this parameter 
are 0”, 1”, and 10”. 

B.29 Volume 

This filter allows the user to put restrictions on the volume associated with the curves to be 
plotted.  There are no curves in this version of the database that have this parameter as a 
constant; therefore, specifying this filter will have limited usefulness.   

B.30 Width 

This filter allows the user to put restrictions on the width of certain geometries.  This is only 
applicable to finite slabs.  There are no curves in this version of the database that have this 
parameter as a constant; therefore, specifying this filter will have limited usefulness. 
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Appendix C CritView Database File  

The CritView code requires a database file that contains all the data available for plotting along 
with associated parametric information.  This file is named critviewdb.txt.  Different versions of 
this database may be distributed using the suffix v###, where “###” represents the version 
number of the database. 

The data included in the database consists of two types: data that has been acquired by 
digitization of existing handbook curves, and data that has been generated by computer 
modeling.  All the data (of both types) has been documented in various reports (see the 
references at the end of this appendix). 

The current version of the database is 1.09 (i.e., critviewdb.txt.v109). 

This version includes the following data: 

• ARH-600 data.  The curves from Section III (which is the bulk of the handbook) are 
mostly present; it omits a few curves based on calculated parameters such as H/X, 
buckling, and migration area.  The curves that are present represent more than 90% of the 
curves in ARH-600.  This data was obtained by scanning and digitizing the plots from the 
original ARH-600 document.   

• LA-10860 data.  All of the curves from this handbook are included.  This data was 
obtained by scanning and digitizing the plots from the LA-10860 document. 

• MCNP data.  Most of the ARH-600 data have been replicated with MCNP version 5.1.40 
and included in this version of the database.  This data set is considered the most reliable 
(having been constructed with modern techniques and peer reviewed and documented).  
Note, however, that even this data does not include any margin for bias, nor does it 
account for statistical uncertainty.  In addition to the ARH-600 data, some MCNP curves 
have been included that are based on ARH-600 but have a lower k-effective (e.g., 
k=0.98). 

• SCALE data. Many (though not all) of the MCNP curves have been reproduced with 
SCALE 6.1. 

Note that ARH-600 includes a good deal of data that is essentially duplicative.  Plots were 
constructed that showed the same basic data but used different axis parameters (e.g., critical 
mass vs. diameter and critical mass vs. concentration).  For these cases, only a single MCNP plot 
was included so there are many more ARH-600 curves than MCNP curves. 

The ARH-600 curves are divided into two groups: “primary” and “secondary.”  This is an 
attempt to avoid duplicate curves in CritView plots.  All of the important curves are included in 
the primary set.  The secondary set consists of curves that are equivalent to curves in the primary 
set (though they may not be identical).  For example, one ARH-600 plot may show a series of 
curves representing a Pu sphere with varying degrees of reflection.  Another plot might show 
unreflected spheres with varying 240Pu content.  Both plots might include a curve representing a 
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bare sphere with 0% 240Pu.  If the CritView user were to filter on bare spheres with 0% 240Pu 
content (without distinguishing between primary and secondary curves) then both curves would 
show up on the plot.  By arbitrarily labeling one curve as primary and any other equivalent 
curves as secondary, CritView allows the user to ensure that only unique curves are included in 
their plot. In addition to the preceding example (where the two curves are essentially identical), 
there are curves in the secondary set that are equivalent in the sense that they can be converted to 
the primary plot.  For example, one ARH-600 plot might show curves, representing bare Pu 
sphere, in units of diameter vs. concentration.  Another plot might show curves representing the 
same spheres but in units of mass vs. concentration.  These curves would be equivalent because 
diameter can be converted to mass for a given concentration.   

The desired set (e.g., “ARH600 primary”) can be selected with the data filter “Data Source” (see 
Appendix B). 

The MCNP plots are all labeled “primary”.  This has no special significance, it was just intended 
to be analogous to the ARH600 data set, and to allow for future development where an MCNP 
secondary data set might be desirable. 

The development and peer review of the database is described in a group of Hanford and SRNS 
documents identified in the references shown below. 
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Appendix D CritView Database File Format 

This appendix provides an overview of the CritView database text file format.  It is not intended 
to provide a complete description (adequate to create a new file) but rather a general guideline 
for users who may want to read the database file directly. 

The database text file can be read by printing it or by loading it into a standard text editor.  While 
it is also possible to edit the file, this is not recommended.  At a minimum, if the file is changed 
in any way, the file should be given a new name and have the details of the change noted in the 
file comment lines. 

The file begins with a title line, two meta commands, and a series of comment lines (which may 
be before, after or intermixed with the meta commands.   

The first (non-comment) line is a title for the database file (e.g., “v1.08 CritView database file”).   

The two meta commands are: 

• DBversion: text  

• CVversion: text  

The text string for DBversion is the version number of the database file (e.g., 1.09).  The text 
string for CVversion is the minimum CritView version with which this database file is 
compatible.  For example, the meta command “CVversion: 1.05” implies that the file can only be 
used with CritView version 1.05 or newer (note that newer versions might not be compatible – 
users will have to check with the user’s guide for the specific version in question). 

The comment lines can provide any desired information but typically provide a change history of 
the database.  Note that any line that begins with an exclamation point (“!”) is a comment (i.e., 
ignored by CritView). 

Following the change history lines, the rest of the file consists of a series of curves.  Each curve 
consists of header information followed by a number of data points.  The header information is 
indicated by a keyword (e.g., “title”) followed by a colon and a blank space, followed by the 
applicable data.  The keywords are, for the most part, optional and may be presented in any 
order.  There are, however, two exceptions: the keyword “reset” must always be present and 
must be the first line of each curve.  The keyword “var” must be present at least twice (i.e., two 
distinct lines) and must be presented in the same order as the values in the data points (i.e., the 
first occurrence corresponds to the first column of data, the second occurrence corresponds to the 
second column, etc.).  The “var” keyword will be discussed further below. 

The data points must be presented after all of the keyword data.  Each data point consists of two 
or more values on a single line, such that the first value forms the first column, the second value 
the second column, etc.  The first two values typically represent the main variables associated 
with the curve and can be thought of as the X and Y axis values.  Other values (if present) 
represent associated data (e.g., the statistical uncertainty at each point).  There may be any 
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number of data points in a given curve; the data is considered complete when the next occurrence 
of “reset” is encountered. 

Common keywords: 

Reset This keyword marks the beginning of a new curve.  There is no data associated 
with this keyword (however the trailing colon is still required). 

Title The data on this line is an arbitrary alphanumeric string that describes the curve. 

Reference An alphanumeric string that identifies the reference document (and page 
number or figure) that the curve was taken from. 

Created The date that the curve was created or entered into the database. 

Source An arbitrary string used to group different curves together (e.g., “ARH600” or 
“MCNP”). 

Set A second arbitrary string used to group different curves together.  Typically, it 
is treated as a subset of the group identified with the “source” keyword (e.g., 
“ARH600 primary”). 

Geometry A flag that identifies the geometry of the curve.  Common values are “sphere,” 
“infcyl” (infinite cylinder), and “infplane” (infinite plane or slab). 

Modmat The moderator material.  Most often this is set as “H2O”. 

Critmat The critical material.  There are a number of different possible values, such as 
Pu (elemental), UO2, Pu – nitrate, etc.  The actual name is arbitrary but must be 
the same as other curves that represent the same material. 

Fiss-element  The element(s) included in the material represented by the curve (e.g., 
plutonium). 

Fiss-form  The form of the material represented by the curve (e.g., metal water mixture). 

Isomat This keyword identifies the nuclide fraction of the fissile elements and isotopes 
represented by the curve.  An example entry is “PU240 0.2 PU239 0.8”, 
indicating plutonium with 20% 240Pu and the rest 239Pu. 

Reflmat The reflector material.  The most common entries are “H2O” and “none.” 

Refthick: The thickness of the reflector associated with the curve.  The data on this line 
includes a numerical value followed by an alphanumeric units designator (e.g., 
“10.0 in”). 

keff The keff value of the configuration associated with the curve.  Most often this is 
1.0. 
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Var The var keyword must occur once for each value in the data points that make up 
the curve (most often there are two values, so the keyword must occur twice).  
The data on the “var” line is a name associated with the parameter represented 
by the value, and an associated units designation (which may be blank in some 
cases).  Two of the most common values are “critconc g/cc” (indicating critical 
concentration in units of g/cc), and “Diameter in” (indicating diameter in 
inches). 
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Appendix E Known Issues and Error Reporting 

The newest version of CritView represents a significant revision and all known bugs have been 
resolved. There are, however, still a few known issues that need improvement, and there are 
undoubtedly some bugs yet to be found.  The known issues are listed at the bottom of this 
section.  We always appreciate help in improving the code, including identifying errors and 
making suggestions.  If you find errors or have suggestions, please send them to the code 
custodian as indicated on the NCSP web page. 

Note: when a code crashes Windows typically produces an error message that includes the nature 
of the error, the module name, the line number, and sometimes the variable name.  This 
information is of surprisingly little use when debugging Windows code because most often it 
only points to some internal Microsoft library function.  Nevertheless, please include it with any 
bug report if you can.  The most important information to provide is how to reproduce the error 
or, at least, what you were doing when it occurred.  The particular version of the code (found in 
the About popup, accessible from the Help menu) and of the database (also found in the About 
popup) are also important information to include in any bug report. 

Known Errors and Limitations: 

• Nuclide content (e.g., percent 240Pu) cannot currently be used as an axis parameter. 

• File Export - jpeg option does not allow compression. 

• Some fonts do not work for the Y-Axis label.  In addition, some fonts will appear as 
designed on the screen but will not print correctly.  This is primarily true for certain older 
non-True-Type fonts, in particular the WST fonts that were included with some versions 
of Microsoft Windows.  Most common fonts work without issue. 

• Curve Plotting Loop – Occasionally, mostly when attempting to plot a very large number 
of curves, Windows will go into a loop where it repeatedly draws the same curves over 
again.  If this happens, it is best dealt with by placing the CritView window behind some 
other window (e.g., File Explorer) and allow CritView to finish drawing in the 
background. 
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